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ESSAY FORMATTING SPECIFICATIONS—MLA STYLE  

PAPER 
• Use 8 ½ X 11 inch white paper 
• Print on one side of the paper only 

MARGINS 
• 1” on all sides (top, bottom, left, right) 
• Set the margins of the paper under “File” => “Page Setup” before starting to type 
• Do not “justify” the margins on the right side of the page 

FONT 
• All essays should be typed in Times New Roman, 12 point font.  This includes the heading, title, and essay text. 
• Do not “bold” anything 

SPACING 
• The entire document should be double-spaced.  That includes the heading, title, body of the paper, and works 

cited page (if applicable). 
• Before you start typing, set the document to double spacing.  Simply press “CTRL + 2” or: 

o Select “Format” => “Paragraph” 
o Under “Line Spacing,” select “Double” from the drop-down menu 

 
PAGE NUMBERS 

• All pages should be numbered consecutively throughout the paper, including works cited pages 
• Page numbers should be placed in the upper right-hand corner of all pages 
• Should contain the student’s last name, one space, and then the page number 
• Set up on the document’s first page in the document header: 

o Go to “View” => “Header and Footer” 
o When the Header box appears at the top of the page, tab over to the right side of the box 
o Type your last name, then hit the space bar one time 
o In the Header and Footer box that appears on the screen, click on the first icon (a piece of paper with a # 

on it).  This will automatically place the numbers on your pages for you ½ inch below the top of the page. 
o Close the Header and Footer box 

HEADING 
• A 4-line heading is on the first double-spaced line following the page number. 
• The heading should be placed in the upper-left corner of the first page of the paper. 
• Heading should include: 

o Student’s First and Last Name (Line 1) 
o Teacher’s Name (Line 2) 
o Full Course Name (Line 3) 
o Date:  Day, Month, Year (Line 4)—Example:  8 February 2007 

TITLE 
• A title is centered on the first line below the 4-line heading. 
• It is double-spaced like the rest of the document—do not excessively space around the title. 
• The title is NOT in bold, NOT underlined, and NOT italicized. 

 
PARAGRAPHS 

• Indent the first line of each new paragraph one tab—do not use the space bar to indent. 
• Do not excessively space in between each paragraph. 
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STYLE 
 

1. Avoid sexist language in pronoun reference. To correct, try to write around the problem: 
a. Everyone bought his book. (sexist) 
b. Everyone bought his or her book. ( non-sexist but awkward) 
c. All the students brought their books. ( non-sexist and more stylistic) 

2. Avoid taboo words: 
a. a lot, there 
b. just, even, due to, really, super, got, gotten, cuz, ‘cause 
c. colloquialisms (slang)  
d. Instant messaging or text messaging lingo such as LOL 
e. BE Verbs: am, is, are, was, were, be, being, bee n 

3. Avoid using abbreviations including etc.  
4. Avoid using ampersands (&)  
5. Avoid using passive voice 
6. The possessive form of it has no apostrophe. (The dog chewed its bone.) 

The contraction of it is takes an apostrophe. (It’s almost midnight.) 
7. Do not use of when you mean have.  

Wrong: I could of gone to the game last night. 
Right: I could have gone to the game last night. 

8. Numbers from one to nine are usually written as words; all numbers are usually written as 
words; all numbers 10 and over are usually* written as numerals. 

• Use words to express numbers in the following constructions: 
1. Numbers which begin a sentence. (Fourteen students forgot their 

assignments.) 
2. Numbers which precede a compound modifier that includes a figure. (The 

chef prepared twelve 10-foot sub sandwiches).  
 

PUNCTUATION 
1. Avoid using exclamation marks. 
2. Comma rules: 

A. Use commas before coordinating conjunctions (BOY S FAN) when they 
join independent clauses . 
EX. Acquiring a skill demands perseverance, but the rewards are great. 

B. Use a comma after an introductory subordinate cl ause, after an 
introductory of phrase, or after a series of introd uctory phrases. 
EX. If students wish to make honor roll, they must work hard. 
 

C. Use commas to separate items in a series. 
EX. The library is large, clean, and quiet. 
EX. We sat in the shade, under a tree, by the pond. 

D. Use a comma to separate two or more adjectives p receding a noun. 
EX. Jane is an intelligent, lively girl. 

E. Use a comma to set off nonessential clauses or p hrases. 
EX. My brother, who is ten, plays the piano. (nonessential) 
EX. All students who don’t study deserve to flunk the course. (essential) 

F. Use commas to set off elements which interrupt t he sentence. 
EX. Appositive: noun or pronoun which follows another noun or pronoun and 
renames it. Mr. Smith, my doctor, is competent. 
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EX. Parenthetical expression: a side remark. It seems, however, that you 
should go.  
EX. Direct address: name or title. I believe, sir, that you are wrong.  
EX. Interjections. Well, I think I’ll go. 

G. Use a comma to set off items in dates, addresses , and geographical 
names. 
EX. Chicago, Illinois, is known as “the Windy City.” 
EX. My sister was born on May 12, 1988, at midnight. 

H. Use commas to separate in a direct quotation fro m the rest of the 
sentence. 
EX. “It’s a nice day,” she said, “if it doesn’t rain.” 

I. Use a comma after an introductory adverb. 
EX. Outside, the flowers bloomed. 

 
3. Use a semi-colon to separate two closely related independent clauses, often those showing  

cause/effect relationship. 
    EX. The students studied for the test; they did exceptionally well.  

4. Use a semi-colon before and a comma after a conjunctive adverb which connects two 
independent clauses.  

EX. John was unhappy with the decision; nevertheless, he understood why his 
parents made it. 

 
CONJUNCTIVE ADVERBS: 
Likewise     consequently meanwhile     moreover hence subsequently      
then  accordingly     now 
besides  thus thereafter     still therefore eventually    
nevertheless  otherwise presently    however instead 
 

5. Use a colon to introduce a list. Hint: Colons replace the expression such as and which are and 
are redundant if used with a colon.  

    EX. Pat enjoys these subjects: English, Spanish, and algebra.  
 

“BE” Verbs  
am  is  are  was  were  be  being   been  

 

Linking Verbs  
is  were  appears    turns   feels  continues 
am  be  tastes     remains   seems becomes 

was  been  grows     sounds 
are  being 
Helping Verbs  

is  be   has  do   shall   may 
am  being  have  does   will   might 
are  been   had  did   should  must 

was   would  could            can 
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OPENERS - SPLITS - CLOSERS 
 
OPENERS: a content chunk we put in front of a complete thought – can be one or many words but can’t be another 
complete thought 
 
Sentence Pattern:   Opener device, Subject  Verb 
 
One Word:  Adverb/ Adjective  Skillfully, the carpenter braced the door frame. 
 
Present Participle     Walking down the hall, Leah couldn’t help bumping into groups  
Verb –ing ending, acting as adjective  of kids. 
 
Past Participle     Tired of all the arguing, Bob stood up and glared at his friends. 
Verb- ed, n, t ending, acting as adjective 
 
 
Subordinating Conjunction    Although Brad felt bad, he couldn’t bring himself to apologize. 
 
      Since she had enjoyed her experience last year, Kelly decided to  
      Volunteer to work with the Special Olympics again. 
 
Preposition Phrase     On the dark September evening, nobody wanted to walk through  
      the alley.  
 
      Above my door, my dad found three wasp nests. 
 
Infinitive: to verb     To arrive at school on time, the bus had to leave by 6:00am. 
  
      To balance the teams, Al had to switch four players. 
 
 
SPLITS:  a content chunk inserted into the complete thought- can be one or many words but can’t be another complete 
thought 
 
Sentence Pattern:   Subject   Split device  Verb 
 
Participle      The angry driver, thinking he might lose his temper, chose to stay 
      in the car until the police came. 
 
      The entire team, frustrated with their fourth consecutive loss, voted 
       to hold an extra practice on Saturday. 
 
Relative Clause     Scott, who was a freshman in high school, looked forward to  
who, whom, whose    getting his license. 
which,  that 
      The puppy, which was a Golden Retriever, ate the tennis shoe. 
 
Appositive      George’s brother, the whiniest kid I knew, argued with his mother. 
 
 
Prepositional Phrase     The boat in the river sank when it collided with the barge. 
 
 
CLOSERS- content chunk added on the end of a complete thought- can’t be another complete thought 
 
Participle      Elliott addressed the crowd, hoping they would begin to settle  
      down quickly. 
 
Subordinating Conjunction   The family waited in the shelter until the all-clear siren sounded. 
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Relative Clause    My sister introduced her friend, who turned out to be the girl  
      whose car I had hit yesterday. 
 
Prep Phrase      We argued for two hours about the latest video. 
 
Appositive      The firefighters lowered the body of the child, a four-year-old 
       little girl still holding her doll. 
 
Infinitive: to verb     We couldn’t wait to visit my brother in San Francisco.  
   
  
    
Openers    Splits     Closers 
 
One Word   
 
Prep Phrase    Prep Phrase    Prep Phrase 
 
Participle    Participle    Participle 
 
Infinitive    Infinitive    Infinitive 
 
Subordinating Conj        Subordinating Conj 
 
     Appositive    Appositive     
 

Methods of Paragraph Development  
You might use these methods to develop your paragraphs. 

 
1. Order of time or sequence: Arrange your supports to show the chronological progression from first to last or 

beginning to end. 
 

2. Order of importance:  Build the steps of your argument from those of least to those of most importance, so that 
a sense of climactic movement occurs. 

 
3. Contrast or Comparison: Point out similarities and differences, either by comparing an idea to another it 

resembles or by contrasting it to another from which it differs. 
 

4. Analysis: Break an idea into its logical parts. In literary analysis, a generalization is backed up by a supporting 
quotation, then followed by a statement explaining the relevance, significance, and meaning of the quoted 
details. This pattern may be used more than once in a single paragraph. 

 
5. Descriptive Details: Express how something looks, feels, tastes, sounds, or smells in such a way as to 

communicate the sensations with immediacy. 
 

6. Examples, incidents, or anecdotes: Organize specifics which tell part of a story that explains or justifies the topic 
sentence. 

 
7. Reasons: When the topic sentence leads the reader to ask why a statement is true, the writer responds with the 

corresponding reasons. Lead up to the strongest, which you present last.  
 

8. Cause and effect: This method begins with a cause, stated I general terms, and then lists the specific effects 
from that cause. 
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Connectives Used to Express Different  
Relationships Between Ideas  

 
Types of  
Relationships            Compound Sentences       C omplex Sentences 
 
 
 
            Coordinating             Conjunctive         Subord inating 
                      Conjunctions             Adve rbs               Conjunctions  

Addition   and                           likewise 
                                  moreover 
                                  then 
                                  besides 

 

Contrast  
Or 

Addition 

but                             still 
yet                             nevertheless  
                                  however 
                                  instead                              

 

Cause (or 
Reason) 

and Effect 
(or Result) 

so                              consequently 
for                              hence 
                                  accordingly 
                                  thus 
                                  therefore 

because 
as 
since 
so that 
in order that 

Alternatives  or                               otherwise 
nor 

 

Condition   if 
as if 
even if 
unless 
though 
as though 
although 
even though 

Time                                   meanwhile 
                                  subsequently 
                                  then 
                                  now 
                                  thereafter 
                                  eventually 
                                  presently 

as 
while 
after 
before 
until 
whenever 
when 
as soon as 
since 

Place  where 
wherever 
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PREPOSITIONS 
 

PREPOSITIONS:          COMPOUND PREPS: 

 

about    concerning   since   according to 

  

above   despite   through  ahead of 

 

across   down    throughout  along with 

 

after    during   to   apart from 

 

against   except   toward  aside from 

 

along    for    under   as to 

 

amid    from    underneath  because of  

 

among   in    until   by means of 

 

around   inside    up   except for 

 

as    into    upon   in addition to 

 

at    like    with   in front of 

 

atop    near    within   in spite of   

 

before   of    without  instead of   

 

behind   off       next to 

 

below   on       on account of 

 

beneath   onto       on top of  

 

beside   out       out of 

 

between   outside      owing to 

 

beyond   over    

 

but (meaning except) past   

 

by    regarding   
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GERUND and GERUND  PHRASES  
 

Definition:  A verb form that ends in ING only and is used as a NOUN. 
 
Six Nouns it can be used as: 
SUBJECT:   a verb will follow the subject, not a noun- participle 

Eating is something I enjoy. 
DIRECT OBJECT:   needs an action verb, answers- what / whom 
 S  V (action) DO 

My grandfather likes strolling. 
INDIRCT OBJECT:   needs action verb& direct object 
   answers to/for what   to/ for whom    
 S  V(action)  IO  DO 

Tony gives baking  his best effort.  
OBJECT OF PREPOSITION:  noun/ pronoun of prepositional phrase 

How much enthusiasm do you feel for bowling ? 
SUBJECT COMPLEMENT:  needs linking verb, gives additional info on subject 
 S  V(linking) Subj Complement 
 Rachel’s favorite past time is painting . 
APPOSITIVES:   tells more information about noun/pronoun 
 My hobbies, writing and reading , are quiet activities. 
 

 
 

Parallel Structure  
 

Definition:  Parallel structure is using the same pattern of words to show that two or more ideas have 
the same level of importance. 
 
 Not Parallel: Mary likes hiking, swimming, and to ride a bicycle. 
 
 Parallel: Mary likes hiking, swimming, and riding a bicycle. 
 
 
Samples: 
 
To spend  time together, to adapt  to changes, and to encourage  family members are areas that both 
my family and Tommy’s family need to work on.  
 Device- Infinitive 
  
 
Communicating with family members, expressing  appreciation, and understanding  family roles 
are the struggles my family differs from Tommy’s family.  
 Device- Gerunds 
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 RESEARCH NOTECARD GUIDELINES  
 

1) You must have and use 3X5 note-cards.  One side should be lined, the other should be blank. 
2) Use ink (blue or black) to complete your cards. 
3) Triple check your cards for accuracy before moving on to the next one.  Misspelling an 

author’s name or leaving out a word in a quote could cause serious problems later on. 
4) There are two types of cards:     

 
BIBLIOGRAPHY (SOURCE) CARDS: 

o Bibliography (source) cards contain the MLA citation for a source that you have chosen to use 
as research in a project. Provide a complete source citation with all information that is 
available.  Consult the MLA Guide at the back of this packet for more details on how to create 
the appropriate citation.  A bibliography (source) card should ideally look like the examples 
below. 

 
SAMPLE BIBLIOGRAPHY (SOURCE) CARD (for a magazine article) 

           
 
Tumulty, Karen. “Healthcare has a Relapse.” Time. 11 

March 2009: 42-45. 
 

    
SAMPLE BIBLIOGRAPHY (SOURCE) CARD (for a website with no author) 
           
 
“Pharmacist: Working Conditions.” Career Cruising. N.p., 1999-2010. 

Web. 1 October 2010.     
                                      

    
 
 
INFORMATION CARDS: 

o Each PIECE OF INFORMATION you find in your research and you think you may want to use 
should be placed on a card. 

o Use a NEW CARD for EACH piece of information; that’s one piece of information per card! 
o How many information cards you have for each of your sources depends on how relevant you 

found each source to be.  One source may only give you one good piece of information, while 
another source might have 12 pieces of information you plan to use.  

o Each information card should include, in the upper right-hand corner, the first piece of 
information from the source citation.  This could possibly be the author’s last name or the first 
word from the title of the article.  The word should match the source citation exactly.  This is to 
signify WHERE the information came from.   

o Each information card should have a KEYWORD in the upper left-hand corner of the card to 
remind you what information you wrote on the card.  

o The “meat” of the card is the actual information you put on it.  This includes direct quotes from 
the articles (No Free Standing Quotes) as well as information you plan to use that you have 
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paraphrased or summarized.  Note that you STILL have to give credit to the author even if you 
paraphrase what the author says! 

o You will also need to include the in-text citation at the end of your note in parentheses.  See 
the examples below. 

 
o Last, you should put in the lower right-hand corner if the information on the card is:  

Your own (M) 
Summary (S)  
Paraphrase (P) 
Direct Quote (Q)   

 
SAMPLE INFORMATION CARDS 

Leukemia         Tumulty 
According to Tumulty, “Mr. Bradley died at Mt. Sinai Medical Center of complications 
from chronic lymphocytic leukemia, said Dr. Valentin Fuster, his cardiologist and the 
director of the Cardiovascular Institute at Mt. Sinai” (43).        
          Q 
 
Employers                               “Pharmacist” 
 
According to Career Cruising, a website which helps people find an appropriate career, 
Pharmacist work in many different areas including hospitals, pharmaceutical 
companies, and retail stores. 
             
          P 
           
 

 

*If you would like to “type” your cards, follow the following directions using 
Microsoft Word:   
 

• Go to File and choose Page Setup 
• Select the Paper Tab 
• Change the Width to 5 and the Height to 3 
• Choose the Margins Tab and change top, bottom, left and right margins to .25  
• This will then show the outline of the 3x5 card on your screen  

 
*Then, you can print your cards rather than write them.  Or, you can print and cut to attach to 3x5 
cards.  (This is at the discretion of the teacher.)   
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                                                             Mechanics 
Editing Symbols 

This lists the mechanical errors your teacher may be marking on your compositions. 
 
SYMBOL
  
ab 
 
agr 
 
apost 
 
awk 
 
cap 
 
d 
 
frag 
 
mm 
 
p 
 
rep 
 
ro 
 
sp 
 
ss 
 
sv 
 
trans 
 
u 
 
uw 
 
vt 
 
wc 
 
ww 
 
 

DEFINITION   
 
abbreviation 
 
agreement 
 
apostrophe  
 
awkward   
 
capitalization 
 
diction 
 
sentence fragment 
 
misplaced modifier 
 
punctuation 
 
repetition 
 
run-on sentence 
 
spelling 
 
sentence structure 
 
sentence variety 
 
transition 
 
usage 
 
unnecessary word  
 
verb tense 
 
word choice 
 
wrong word 
 
 
 

EXPLANATION  
 
Either the abbreviation is not appropriate, or it is wrong. 
 
You have made an error in agreement of subject and verb or 
pronoun and antecedent.  
You have made an error in the use of the apostrophe. 
 
The sentence is clumsy. 
 
You have made an error in capitalization. 
 
You have used an informal or inappropriate word. 
 
You have placed a period after a group of words that is not a 
sentence. 
Rewrite the sentence so the modifier phrase or clause will 
modify the word it should. 
Rewrite the sentence with correct punctuation. 
 
Change or delete the unnecessary words. 
 
Rewrite making several sentences of the one. 
 
You have misspelled a word. 
 
Rewrite the sentence so that the structure is correct. 
 
Rewrite the sentences using a variety of beginnings. 
 
Use a transition to indicate the change of direction in your 
thinking. 
You have used a word incorrectly. 
 
Delete the word that is not needed. 
 
You have used the wrong tense. 
 
Your word choice is questionable. 
 
You have used a word incorrectly. 
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1st 
 
2nd 
 
? 
 
// 
 

1st person   
 
2nd person 
 
Illegible or unclear 
 
faulty parallel 
structure 

Change to 3rd person. 
 
Change to 3rd person. 
 
Rewrite 
 
Rewrite so that words, phrases, or clauses are parallel.

 
¶  paragraph   Begin a new paragraph at this point. 
 
∧  omission   You have left out words that are needed.  
 
∼  transposition   You have transposed letters or words. 
 

Writing Development   
Transition Words and Phrases 

 

 Almost anything you examine has some interrelationship or connection.  Buttons and button holes, for 

instance, serve to join the two sides of a shirt; in another case, roads signs allow you to drive from point A to 

point B without getting lost; engineers have designed couplers to link hundreds of freight cars.  It would not be 

difficult for you to think of many more examples, but let’s focus on connections in the world of the writer.   

 As a writer, you must realize that sentences and paragraphs need to be connected too.  When you 

connect them, you provide a sense of movement that allows your reader to follow the main and subordinate 

ideas easily and, as a result, understand your purpose and message. 

 More specifically, to achieve clear and coherent communication, you will have to show distinct 

relationships between sentence and paragraphs.  In turn, you will eliminate confusion, disinterest, and 

frustration among your readers. 

 Writers use seven methods of transition to connect ideas in order to produce first-rate prose.  These 

techniques include using pronouns to refer to words that have already been used; repeating key words; using 

word substitution; repeating key phrases; using end-of-paragraph, or beginning-of-paragraph transition; 

embedding a transitional paragraph; and using transition words and expressions.  Because the last of these 

seven methods is one of the most helpful for you to use, it is the focus of the following pages. 

 Transitional words and expressions are called signal words.  They are placed at key points as a means 

of leading the reader from point to point, from paragraph to paragraph, and from the beginning to the end of a 

piece of writing.  At first you may have the tendency to overuse them.  After practice, these words and 

expressions will become a more natural part of your writing process.  At that time you will be able to use a 

wider variety of transition more sparingly and effectively. 
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To Conclude or To Summarize 

 
to conclude   the final    to complete   as a result 
in conclusion   to finalize   to culminate   the end result 
to close    finally    the culmination of   in sum  
in closing    to finish    thus    to sum up 
last    to terminate   hence   in summary 
last of all    to end    therefore    to summarize 
lastly    to bring to an end  consequently   as a summation 
to recapitulate 
 
To Indicate Time Order 

 
past   present   in the future  sequentially  
in the past  at present   tomorrow   following 
in retrospect  presently   henceforth  following that 
before   currently   soon after   hereafter 
earlier   right away   soon afterward  after 
heretofore  now    thereafter   afterward 
previously  by now   right after   after a short time 
preceding   until   not long after  after a while 
formerly   until now   later   after a long time 
prior to   today   later on   after a few days 
yesterday   immediately  of late   concurrently 
former   simultaneously  recently   during 
formerly   at the same time  not long ago   all the while  
   at this moment       
      
To Indicate How or When Something Occurs in Time 

 
suddenly   sometimes   uncommonly  soon 
all at once  some of the time   infrequently  as soon as 
abruptly   at times    momentarily  just then 
hastily   in the meantime   temporarily  when 
in an instant  occasionally  sporadically  little by little 
instantly    rarely   intermittently  while 
instantaneously  scarcely   periodically  in a while 
promptly   seldom   sequentially  meanwhile 
directly   gradually   eventually  cyclically 
       
 
To Divide or Classify 

 
first   the second section  section   completely 
second   first step   segment   the entire 
third   second segment  segmentation  entirely 
last   third division  part   the whole 
last of all   the last process  partition   wholly 
another type   to classify   element   the single 
another example  to group   the elements of  the multiple 
the next   another grouping  in the same group  multilevel 
one piece   to split   in a different setting  multistage 
a part   to divide   with this arrangement multifaceted 
a second part  to divide further  (un) common traits t o separate 
one of the      the complete  separate from 
 
To Indicate Sequence 

 
first    second    third 
at first    secondly    last 
once    the second stage   last of all 
once upon a time   twice    at last 
begin    next    lastly 
to begin with   the next day   the latter 
at the beginning   the next time   at the end 
at the onset   the following week   final 
starting with   then    the final point 
initially    after that    in conclusion 
commence   in turn    finally 
embark    so far    consequently     from this point    
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To Provide an Example 

 
for example (e.g.)  analogous to   an analogy  to illustrate 
in one example  suppose that   to be exact  an illustration of 
as an example  specifically   more exactly  by way of illustration 
to exemplify  more specifically   in particular  consider as an illustration 
for instance  in this specific instance more particularly  in fact  
in this instance  to explain   such as   incidentally 
in this case  to clarify   namely   in other words 
a case in point  in order to clarify  for one thing  to put it another way 
to show   to illuminate  that is (i.e.)  thus 
to demonstrate  to bring to light  indeed   in order to clarify 
 
 
To Repeat 

 
all in all   to put it differently  to reword   to rethink  
altogether   in other words  to repeat   to reconsider 
on the whole  again   to echo   to reevaluate 
in brief   once again   to reiterate  to reexamine 
in short   again and again   to restate   to clarify 
in effect   as stated   to review   to explain 
in fact   as noted   to recapitulate  to outline 
in particular  in view of   to retrace   to summarize 
that is   in retrospect  to rephrase  in summary 
simply stated  that is to say  to paraphrase  a summation of 
in simpler terms   accordingly  to refresh 
 
 
To Concede 

 
of course   albeit   to surrender  to reconcile 
after all   to admit   to submit   to agree 
granted   admittedly  to succumb  to consent 
at the same time  to concede  to give up   to concur 
naturally   to withdraw  to compromise  to comply with 
unfortunately  to yield   to adjust   to acknowledge defeat 
though   to accede   o settle   to make a concession 
although   to acquiesce  to confess  to admit the truth 
even though  to capitulate  to accommodate  while it is true 
      to conform   although this may be true 
 
 
 
To Contrast 

 
though   on the contrary  another distinction  more 
even though  to the contrary  a strong distinction  less 
although   contrarily   the third distinction  slower 
although true  contradictory  unique   faster 
and yet   on one hand  the next variation  opposite 
but   on the other hand  otherwise   opposing 
To Contrast- Continued  
but at the same time nevertheless  after all   an opposing view 
at the same time  notwithstanding  instead   in opposition to 
despite    still   rather   diametrically opposed 
despite this fact  yet   unlike   in reverse order 
in spite of   still yet   dissimilar to  divergent 
even so   conversely  a dissimilarity  diverse 
for all that   to differ   unequal   conflicting viewpoint 
however   to differentiate  unequally   for 
in contrast  different from  unbalanced\  pro 
in contrast to this  a clear difference  disproportionately  against 
in sharp contrast  a distinct difference  unequivocally  anti 
counter to   a striking difference  larger    the antithesis of 
contrary to  distinct   smaller   although this may be true 
   a distinctive 
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To Indicate Cause and Effect 
 

accordingly  the aftermath  because of this  so  
incidentally  the ramifications of  for this purpose  in fact 
by the way  as a consequence  reason   of course 
owing to   consequently  for this reason  in short 
effect   consequentially  by reason of  little by little 
in effect   after   in view of   gradually 
impact   following that  hence   on this account 
due to   eventually  henceforth  on account of 
result   further   otherwise   made 
as a result  furthermore  since   produced 
is a result of  subsequently  then    yielded 
resulted in  it follows that  therefore   generated 
the end result  created   thereafter   induced 
the end product  cause   thereupon  started 
the by-product of  caused by  thus   precipitated 
the outcome  because   to this end  initiated 
the outgrowth  because of  with this object  launched 
 
To Compare  

 
like    parallel   equate   another similarity 
look like   homogeneous  equivalent  similarly 
in like manner  consistent with  relate to   similar to 
likewise   uniformly   akin   in similar fashion 
liken (ed)   same as   conform   analogous to 
likeness   in the same way  harmonize  compare 
the next likeness  by the same token  coincide   comparable  
resemble   synonymous with  match   a comparable aspect 
resembling  identical   parallel to   in comparison 
resemblance   equal   also   correspondingly  
a strong resemblance equally   exactly    in much the same way 
correlate   equally important  similarity    affinity 
 
To Indicate Spatial Arrangement 

 
in     down   near  further   surrounding  
out     downward  nearby  further back  around 
under     behind   nearest  furthest   encircling 
over     to the back  close by  furthermost  perpendicular to 
above     in the background  close to  in the distance  horizontally 
overhead      further  back  closest  on the other side  horizontal to 
top     in front   next to  on the opposite side  vertically 
atop     in the foreground  adjacent to opposite to  vertical to 
on top of       on the right  adjoining  to the east, west…  paralleling 
up      on the left  abutting  beside   parallel to 
upward     here   juxtaposed inside   at a tangent 
on      there   neighboring outside   tangentially 
below     thereabouts  bordering  alongside 
bottom     wherever  far  against the side 
on the bottom of       elsewhere  far away  side by side 
at the base of    everywhere  far from  on this side 
beneath        anywhere  farther on on all sides 
 
 
To Add a Point 

 
again  second   although  next to last  no only…but also 
once again in the second place  in conclusion following   notwithstanding 
repeatedly secondarily  farther  subsequently  however 
also  third   further  likewise    or 
too  last    furthermore similarly    either…or 
as well as  last of all   plus  in like manner   nor 
besides  final   in addition above all   neither…nor 
equally  finally   in addition to most of all  more 
equally important yet   additionally least of all   moreover  
first  but   to add to that and    once more 
first of all  but…then   another  and then   for one thing 
in the first place nevertheless  next  still   primarily  
initially  though     still yet 
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To Emphasize or to Intensify 

 
above all   the chief characteristic absolutely   more and more 
indeed   the most dramatic  positively    incremental 
in fact   the major point, reason surely    of major interest 
primarily   the main problem, issue to be sure   notably  
chiefly   the most necessary  of course    noteworthy 
notably   repeatedly  obviously    as a result 
secondarily  to repeat   naturally    undoubtedly 
more important  to recapitulate  truly    without a doubt 
more importantly  to emphasize  verily   doubtlessly 
even more important more emphatically  in truth    indubitably 
most important of all or great (er) consequence very likely   certainly  
most of all  to accentuate  assuredly   the turning point 
increasingly important to underscore  to culminate   to enlarge upon 
equally   to amplify   the culmination   to add to that 
equally important  to enlarge   the acme    yes  
instead   to highlight  the peak    without question 
moreover   to stress   the apex    unquestionably  
furthermore  strikingly   the apogee   there is no question that 
considerable more  definitely   the crux    increasingly 
significantly  decidedly   the climax of   you can be sure  
the most significant  by all means  the epitome   intensifying 
of great (er/est) concern unequivocally  climatically 
     
 
 
Regardless 

 
nevertheless  however   in spite of   nonetheless 
despite   because   for  
 
 
 
Paralleling Coordinators      

 
not only…but also  either…or   both…and  neither…nor 
if so…then  not…but   …as well as  
      
 
      
 
Argument For or Against 

 
besides   after all   in fact   otherwise 
in any case  certainly   at any rate  all the same 
incidentally  needless to say  indeed  
 
 
 
Explanations   

in effect   in other words  under the circumstances      

 
 

Descriptive Words  
Touch:  
cool  cold  icy        warm  tepid  lukewarm  
steamy damp  wet        fleshy rubbery tough 
slippery mushy oily        crisp  elastic leathery 
silky  gritty  satiny       sandy  smooth sharp  
rough  thick  pulpy         dry     dull  thin 
fragile  tender prickly       hairy  fuzzy  feathery 
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furry  
 
Taste:  
tangy  gingery hot           burnt  overripe spoiled 
rotten  unripe raw  alkaline medicinal fishy 
spicy  peppery oily  buttery salty  bitter 
bland  crisp   hearty mellow sugary ripe 
sour  tasteless fruity  vinegary  bittersweet 
Smell:  
sweet  minty  acidy  sickly  scented odorous 
acrid  stagnant fragrant pungent burnt  moldy 
musty  gaseous tempting aromatic perfumed spicy 
reeking mildewed heady  savory putrid  damp 
fresh  sharp  rotten  dank  stench earthy 
fishy  sour  spoiled gamy  piney  rancid 
 
Sounds:  
crash  thud  bump  thump boom  thunder 
bang  smash explode roar  scream screech 
shout  yell  whistle whine  squawk bark 
bawl  rage  blare  rumble slam  clap 
stomp  stamp  discord jangle  rasp  clash clamor tumult 
hubbub blatant deafening raucous       patter  hum 
piercing rowdy  disorderly  sigh  murmur  peep 
whisper whit  rustle  twitter  bleat  swish 
mutter  snap  hiss  crackle buzzing gurgle 
still     mute  faint  inaudible melody speechless earsplitting   
  
Sight:  
flashy  formal frail  elegant scrolled tampering 
branching twiggy split  broken skinny square 
thin  shapely winged shapeless roiled  unruffled 
scalloped ruffled frilled  crimped crinkled calm 
flared  oval  conical sunny  wiry  cylindrical 
tubular hollow rotund chubby portly  pleasant 
swollen lumpy  clustered padded tufted  pendulous 
jutting  irregular angular triangular wild   proportioned 
fiery  blazing verdant fresh  clean  scrubbed 
fragile  pale  pasty  sickly  small  tiny 
miniature timid  shy  fearful tearful nervous 
frightened terrified hysterical tall  lean  slender 
hardy  strong healthy robust sturdy  lively 
orderly straight curved loose  crooked awkward 
exhausted tired  ugly  cheap  messy shabby 
worn  old  used   tied  packed rigid 
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dull  drab  muddy stout  wide  heavy 
 
 
 
 
 
 
 
 
COLORS:  
Brown White  Red  Yellow  Gray  Black      
sandy  snowy rose  beige   ashed  jet 
almond milky  pink  buff  dove  ebony 
amber marble salmon straw  steel  licorice 
tawny  cream coral  peach  silver     
hazel  ivory  raspberry apricot   
cinnamon oyster  strawberry butter          Green           Purple  
nutmeg pearl  tomato buttercup  celery  lilac  
chocolate platinum currant lemon  mint  orchid  
coffee    crimson chartreuse  apple  mauve  
rust    flame  citron  lime   plum 
    ruby  canary   mulberry  

 
Blue  Orange        
sapphire gold         
delft  topaz         
porcelain ochre  
turquoise mustard  
aqua  tangerine  
violet  persimmon  
peacock    
 
Substitutes for VERY: 
intensely  exceedingly  bitterly surely  especially 
unusually  truly   richly  mightily powerfully 
immeasurably infinitely  severely chiefly shockingly 
slightly  incredibly  fully 
 
Synonyms for… 
Fast:      Slow: 
hurry  run scamper  creep  crawl  plod 
skip  dart scramble  slouch bend  tiptoe   
      saunter loiter  stray 
      slink  stalk  edge 
      sneak  lumber 
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Dead Words:  
get  very  your  good  lots  well  
got  great   so  nice  you  just  
a lot  fine  fun  every  the end 
 
AVOID: ALL CONTRACTIONS  (won’t, I’d, We’ll) 

    ALL ABBREVIATIONS  (etc. o.k., CA) 
     ALL SLANG 
  

SYNONOYMS FOR SAID 
acknowledged 

acquiesced 

added 

addressed 

admitted 

admonished 

advised 

advocated 

affirmed 

agreed 

alleged 

allowed 

announced 

answered 

approved 

argued 

assented 

asserted 

assumed 

assured 

asked 

attested 

avowed 

babbled 

bantered 

bargained 

began 

boasted 

called 

claimed 

commented 

complained 

confided 

contradicted 

cried 

debated 

decided 

demurred 

denied 

denounced 

described 

dictated 

directed 

disclosed 

disrupted 

divulged 

drawled 

droned 

elaborated 

emphasized 

enjoined 

entreated 

enunciated 

estimated 

exclaimed 

explained 

exposed 

expressed 

faltered 

feared 

foretold 

fumed 

giggled 

grinned 

grunted 

help 

implied 

indicated 

inferred 

instructed 

itemized 

laughed 

lectured 

lied 

maintained 

mentioned 

mimicked 

moaned 

mumbled 

murmured 

mused 

muttered 

nagged 

narrated 

noted 

notified 

objected 

observed 

opined 

orated 

ordered 

petitioned 

pleaded 

pled 

pointed out 

prayed 

predicted 

proclaimed 

professed 

prompted 

propounded 

publicized 

quibbled 

ranted  

reassured 

reciprocated 

refuted 

related 

remonstrated 

repeated 

replied 

responded 

restated 

resumed 

retorted 

returned 

reveal 

roared 

ruled 

sanctioned 

scoffed 

scolded 

screamed 

shouted 

shrieked 

snapped 

sneered 

sobbed 

solicited 

specified 

spoke 

sputtered 

stammered 

stated 

stipulated 

stormed 

stressed 

suggested 

taunted 

thought 

threatened 

told  

twitted 

urged 

uttered 

vowed 

wailed 

warned 
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ADVERBS NOT ENDING IN –LY  

 
 

already away  far  fast  here 
late  most  nearby not  now 
often  out  over  quite  rather 
sometimes soon  then  there             today 
together tomorrow too  very  well 
yesterday 

ACTION WORDS 

 

aching 

babbling 

bashing 

battering 

beaming 

beeping 

bickering 

blaring 

blinding 

blinking 

blistering 

bubbling 

cackling 

crackling 

chanting 

chatting 

chugging 

clanking 

clucking 

coughing 

creeping 

crowing 

crooning 

crunching 

dazzling 

 

dancing 

dribbling 

drifting 

engulfing 

entertaining 

flailing 

flapping 

flaring 

flickering 

flittering 

flopping 

floating 

flowing 

fuming 

glaring 

gliding 

glistened 

glittering 

glowing 

grinding 

groaning 

gunning 

hissing 

hooting 

inviting 

jerking 

jumping 

kicking 

kissing 

laughing 

leaping 

lighting 

loaning 

moaning 

mocking 

mumbling 

munching 

nailing 

nicking 

pattering 

peeping 

piling 

plopping 

popping 

pouncing 

pounding 

quacking 

rattling 

reflecting 

roaring 

rumbling 

sailing 

scolding 

smoking 
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shrieking 

sizzling 

slapping 

sloshing 

smashing 

sparking 

sputtering 

sprinkling 

spinning 

splashing 

soaring 

squawking 

streaking 

thumping 

thundering 

trilling 

twinkling 

wailing 

winding 

wheezing 

whipping 

whirring whisking 

whistling 

 

 
Commonly Mixed-Up Words  

Accept vs. Except 

• Accept - a verb meaning to receive 
• Except - generally used as a preposition meaning excluding 

Advice vs. Advise 

• Advice - a noun (I need some advice.)  
• Advise - a verb (We advise you to follow these instructions.)  

Affect vs. Effect 

• Affect - a verb, meaning to influence 
• Effect - a noun, meaning the result 

 

Among vs. Between 

•  Among is used with three or more entities (There was consensus among the five partners.) 
•  Between is used with two entities (You can choose between chicken or fish.)  

All ready vs. Already 

• All ready - means completely prepared (Sharon was all ready for her presentation.)  
• Already - means previously (The slides were already prepared.)  

All right vs. Alright 

• All right is always written as two words.  Alright is not standard.  

Assure, Ensure, and Insure 
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• Assure - means to tell someone something is true or will happen, often to make them less 
worried (Please assure Matt that the job will be ready for the deadline.)  

• Ensure - means to make sure something happens (Her reputation ensures her acceptance.)  
• Insure - refers to a financial transaction where you pay money to a company so that if 

property is lost, stolen or damages, the company will replace that property 

Complement vs. Compliment 

• Complement - a verb meaning "to complete", or a noun meaning 'something that completes 
(The new rep complements our team.)  

• Compliment - a verb meaning 'to flatter,' or a noun meaning 'a flattering remark' (Our flower 
arrangements receive many compliments.)  

Explicit vs. Implicit 

• Explicit - means expressed directly, or clearly defined  (She gave explicit instructions.)  
• Implicit-  means implied or unstated (No comment indicates his implicit approval.)  

Farther vs. Further 

• Farther – refers to actual, physical distance (She kicked the ball three feet farther.)  
• Further – refers to matters of intellect (The directions confused him further.)  

Good vs. Well 

• Good is an adjective (Henry did a good job.)  
• Well is an adverb (Norman writes well.)  

Infer vs. Imply 

• Infer – one who listens infers 
• Imply – one who speaks implies 

Its vs. It’s 

• Its - the possessive for it (The dog ate its supper.)  
• It's - the contraction for “it is” (It's another hot day.)  

Less vs. Fewer 

• Less – use for things you can measure, but not count  
           (If I had less clutter, my desk would be cleaner.)  

• Fewer – use for things you count individually  
           (Purchase ten items or fewer at the express checkout line.)  

Lie vs. Lay 
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• Lie – people and dogs lie down, no objects involved (Go lie down and take a nap.)  
• Lay – requires an object to put down somewhere  (Please lay your book on the desk.)  

Lose vs. Loose 

• Lose – verb meaning to misplace, to suffer the loss of, to not win   (He lost his house key.)  
• Loose – adjective meaning the opposite of tight  (She loosely tied a scarf around her neck.)  

More than vs. Over 

• More than – use with amounts and quantities (I have more than 15 candies.)  
• Over – use to describe physical proximity (The book is over there.)  

Principal vs. Principal 

• Principal - a noun meaning the head of a school, or an adjective most important  
(Our school has a new principal. He stated his principal reason for quitting his job.)  

• Principle - means a law or truth (We believe in the principle that you are innocent until 
proven guilty.)  

Set vs. Sit 

• Set - to place something deliberately, arrange, or adjust; requires an object   
   (Please set your book on your desk.) 

• Sit - to put your bottom in a chair or to rest  (Please sit in your chair.)  

Than vs. Then 

• Than- used in comparisons   (She is shorter than you are.)  
• Then - an adverb that denotes time  (First put the key in the ignition, then turn it.)  

That vs. Which 

• That - used for restrictive clauses (Let’s go to the restaurant that makes the best spaghetti.)  
• Which - used for non-restrictive clauses and is generally preceded by a comma.  

          (The restaurant, which makes the best spaghetti, is located in St. Louis.)  

Their, They’re, There 

• Their - a possessive pronoun 
• There - an adverb indicating direction 
• They’re - a contraction for “they are” 

Your vs. You’re 

• Your - a possessive pronoun (Remember your briefcase.)  
• You're - the contraction meaning for “you are” (You're getting a raise.)  
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Avoiding Wordiness  
 
Wordy   Concise  
a large number   many 
accordingly   so 
adjacent to   next to 
along the lines of  like 
as to    about 
at such time   when 
at the present time  now 
been desirous of  wanted 
by the use of   with 
consequently   so 
demonstrates that there is shows 
doubt but that   doubt 
duly     (omit it ) 
during the time that  while 
for the reason that  because  
for this reason   therefore 
function   purpose 
if the developments 
 are such that   if 
in as much as   because  
in case    if 
in close proximity to  near 
in favor   for 
in order to   to 
in the event that  if 
is applicable   applies 
more specifically  specifically 
not later than   at 
on account of   because  
on the grounds that  because 
on the part of   of 
over and above  beyond 
presently   now 
prior to    before 
subsequent to   after  
take into consideration consider 
 
 
 
 
 
 
 
 
 
 
 

 
 
Wordy   Concise  
 

   the greatest percentage most 
   under the provisions of under  
   utilize   use 
   with a view to  to 
   accomplished by  done 
   as in the case  as is true 
   at the time   when 
   augment   increase  

begin that    because 
conditions that exist  conditions 

   despite the fact that  although 
due to the fact that  because 
employ   use 
expedite   help 
for the purpose of  for 
has a tendency  tends to 
he informed me that  he said 
implement (verb)  put into effect 
in the course of   during 
in order that   so 
in the nature of  like 
in the neighborhood of near 

     in view of the fact that because 
is equipped with  has 
make an approximation  estimate   
most of the times  usually 
of the order of   about    
on the occasion of  when 

    outside of   except 
pertaining to   on 
subject of a controversial controversial  
nature    subject 
that is to say   in other words  
the likelihood of  likely  
which are known  as known as 
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Works Cited Entry Packet - MLA Seventh Edition  

O’Fallon Township High School 
 

Table of Contents 

Print Sources Electronic Sources Other Media 

Anthology 29 Article from Database such as 

Gale 

33 DVD 35 

Book  27 Image from Electronic Source  33 Image or Painting  35 

Book for Controversial 

Issues 

28 Movie/Film Review  33 Radio Program  35 

Encyclopedia 29 Online Newspaper 32 Song 35 

Interviews 31 Online Magazine  32 TV Show 35 

Introduction, Preface, 
Foreward, Afterword, 
Jacket Cover, Embedded 
Text, or Quotation  

29-30 Online Scholarly Journal 34 Videotape  35 

Magazine Article  30 Questia  33   

Map or Chart  31 United Streaming 34 Appendices  

Movie Review 32 Video Clip 34 A Answers to Frequently 

Asked ?s 

Newspaper Article 30 Website 32 B General Formatting for 

MLA 

Pamphlet  30   C Sample First Page of 

Paper 

Reference Book Article  29   D Sample Works Cited 

Page 

Scholarly Journal  30   E In-text Citations  

Speech or Lecture 31     

____________________________________________________________________________ 

Instructions for Use of This Packet:  

• The punctuation shown here is not optional.  Punctuation is an important part of MLA standards and 
should be followed precisely as it is seen here.  

• Any explanatory notes are found in [ ] behind the item being explained.  The information in the 
brackets should not be directly copied into the entry.  
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Print  Sources 
� BOOK 

Author’s Last Name, Author’s First Name. Title of Book. City of Publication: Publisher, Copyright Year.  

 Print. 

 

Author Variations : (Book examples are shown here but the concept applies to other entry types as well) 

One Author: 

Castro, Elizabeth.  Creating a Web Page with HTML. Berkeley: Peachpit Press, 2005. Print. 

Two Authors: 

Riddle, John, and Rae Simons. Veterinarian. Broomall: Mason Crest Publishers, Inc., 2003. Print. 

More than Two Authors:  

Booth, Wayne C., et al. The Craft of Research. Chicago: University of Chicago Press, 2003. Print.  

 
Editor – No Author (common in reference books) 

Editor’s First and Last Name, ed. Title of Book. City of Publication: Publisher, Copyright Year. Print. 

Example of Editor – No Author: 

Brunner, Borgna, ed. Time Almanac 2006. Boston: Information Please, 2005. Print. 

 
No Author – No Editor:  

Title of Book. City of Publication: Publisher, Copyright Year. Print. 

Example of No Author – No Editor:  

Hammond World Atlas. Italy: Hammond World Atlas Corporation, 2000. Print. 

 
Corporate Author:  

Name of Corporation, Association, Committee, or Group. [omit “a”, “an”, or “the”] Title of Book. Ed. 

 Editor(s)’ First and Last Name(s). [if given] City of Publication: Publisher, Copyright Year. Print. 

Example of Corporate Author: 

US News and World Report. What College Really Costs. Ed. Margaret Mannix. Naperville: Sourcebooks, 

 Inc., 2005. Print.  
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� BOOKS FOR CONTROVERSIAL ISSUES  

(See specific examples from the library collection that follow) 

Author’s Last Name, Author’s First Name. “Title of Article.” Title of Original Source Publication Date of  

 Original Source. Rpt. in Title of Book. Ed. Editor(s)’ First and Last Name(s). Title of Series. City of  

 Publication: Publisher, Copyright Date of Series. Page Number(s). Print.  

 

Contemporary Issues Example: 

Paige, Sean. “Professional Athletes as Role Models.” Insight on the News 3 Aug. 1998. Rpt. in Professional  

Sports. Ed. James D. Torr. Examining Pop Culture. San Diego: Greenhaven Press, 2003. 171-180. 

Print.  

 

Opposing Viewpoints Example: 

Leshner, Alan I. “Addiction is a Brain Disease.”  Issues in Science and Technology Spring 2001. Rpt. in Drug  

Abuse. Ed. Tamara L. Roleff. Opposing Viewpoints. Detroit: Greenhaven Press, 2003. 68-77. Print. 

 

 
Current Controversies Example: 

Kelling George L. “Aggressive Policing Does Not Encourage Police Brutality.” Wall Street Journal 23 Mar.  

 1999. Rpt. in Police Brutality. Ed. Louise I. Gerdes. Current Controversies. San Diego: Greenhaven  

 Press, 2004. 74-77. Print.  

 
At Issue Example: 

English, Brian J. “Threats to Coral Reefs Face Many National and Human Threats.” Threats to Coral Reefs  

2000. Rpt. in Are the World’s Coral Reefs Threatened? At Issue. Detroit: Greenhaven Press, 2005. 39-47. 

Print.  

 
Reference Shelf Example: 

Slater, Eric. “Monterey Bay Canoys is a Role Model.” Los Angeles Times 10 Aug. 2004. Rpt. in U.S. National 

  Debate Topic 2006-2007: National Service. Ed. Ronald Eniclerico. The Reference Shelf. New York: 

The H.W. Wilson Company, 2006. 131-36. Print.  
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� WORK IN AN ANTHOLOGY  

Author’s Last Name, Author’s First Name. “Title of the Essay, Short Story, Poem, or Work.” Title of the  

Anthology. Ed. Editor(s)’ First and Last Name(s). [if given] City of Publication: Publisher, Copyright  

Year. Page Number(s). Print.  

 
Example: 

Keats, John.  “Ode to a Grecian Urn.”  The Norton Anthology World Masterpieces.  Ed. Maynard Mack.  

 New York:  W.W. Norton and Company, 1995. 821. Print.  

 
� MULTIVOLUME SOURCE OR ENCYCLOPEDIA  

Author’s Last Name, Author’s First Name. [This is the author of the article – found at the beginning or end of  

 the article – if given] “Title of Article.” Title of Book. Ed. Editor(s)’ First and Last Name(s). [if given]  

 Vol. Volume Number. City of Publication: Publisher, Copyright Year. Page Number(s). Print.  

 
Example: 

Mastrandea, Michael D., and Stephen H. Schneider. “Global Warming.” World Book Encyclopedia. Vol. 8.  

 Chicago: World Book, Inc., 2003. 232-32b. Print.  

 

� ARTICLE IN A SINGLE REFERENCE BOOK  

Author’s Last Name, Author’s First Name. “Title of Article.” Title of Book. Ed. Editor(s)’ First and Last  

 Name(s). [if given] City of Publication: Publisher, Copyright Date. Page Number(s). Print.  

 
Example: 

Hamm, Richard F. “Common-Law Court.” The Oxford Companion to the Supreme Court. Ed. Kermit L. Hall.  

 New York: Oxford University Press, 1992. 171. Print.  

 
� INTRODUCTION, PREFACE, FOREWORD, AFTERWORD,  

JACKET COVER, EMBEDDED TEXT, OR QUOTATION  

Author’s Last Name, Author’s First Name. [author of the passage] Type of Passage. [types listed above] Title  

of Passage. [if applicable] By Author of Book. [or editor if author isn’t given] City of Publication:  

Publisher, Copyright Year. Page Number(s). Print.  
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Example: 

Cowley, Malcolm. Introduction. The Stories of F. Scott Fitzgerald. Ed. Malcolm Cowley. New York: Charles 

  Scribner’s Sons, 1951. vii-xxv. Print.  

 
� ARTICLE IN A MAGAZINE  

Author’s Last Name, Author’s First Name. “Title of Article.” Title of Magazine Publication Date: Page  

 Number(s). Print.  

 
Example: 

Schneider, Karen S., et. al. “A Sobering Decision.” People 6 Nov. 2006: 48-51. Print.  

 
� ARTICLE IN A NEWSPAPER  

Author’s Last Name, Author’s First Name. “Title of Article.” Title of Newspaper Publication Date: Page  

 Number(s). Print.  

 

Example: 

O’Neil, Tim. “Officials Expect Long Lines at the Polls.” St. Louis Post-Dispatch 2 Nov. 2006: A6. Print.  

 

� ARTICLE IN A SCHOLARLY JOURNAL  

Author’s Last Name, Author’s First Name. “Title of Article.” Name of Periodical Volume Number. Issue  

 Number  (Publication Year):  Page Number(s). Print.  

 

Example:  

Chang, Patricia. “What’s next for Iraq?(After the U.S. leaves).” The Christian Century 126. 8  (2009): 23.  

 Print.  

 
� PAMPHLET  

Sponsor of Pamphlet. Title of Pamphlet. Place of Publication: Publisher, Year. Print.  

 
Example: 

Bureau for At-Risk Youth. Violence. Huntington: 1994. Print.  
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� SPEECH OR LECTURE  

(Possibly by One of Your Esteemed Teachers) 

Speaker’s Last Name, Speaker’s First Name. “Title of Speech or Lecture.” Sponsoring Organization. City,  

 State Where Speech or Lecture was Delivered, Date of Speech or Lecture. Form of Delivery [Address,  

 Lecture, Keynote speech, or Reading]  

 
Example: 

Bickel, Rich. “The Illustrious and Adventurous History of the U.S. Foreign Service.” O’Fallon Township 

 High School. O’Fallon, IL, 8 Nov. 2006. Lecture.   

 
� PUBLISHED INTERVIEW  

Last Name of Person Interviewed, First Name of Person Interviewed. Name of Person Conducting Interview.  

[include the words “Interview with”] Title of Source. Source’s Publication Date: Page 

Number(s).Medium of Publication [Print, Radio, DVD, Television] .  

 
Example: 

Streisand, Barbra. Interview with Oprah. O, The Oprah Magazine. Oct. 2006: 296-99+. Print.  

 
� INTERVIEW (conducted by you) 

Last Name of Person Interviewed, First Name of Person Interviewed. Personal Interview. [Could also be  

 “Telephone Interview” or “E-mail Interview”] Date Interview was Conducted. 

Example: 

Wilson, Robert. Personal Interview. 16 April 2006. 

 
� MAP or CHART  

Title of Map or Chart. Description. [use the word “Map” or “Chart”] City of Publication: Publisher, Date of  

Publication. 

Example: 

Michigan. Map. Chicago: Rand, 2000. 

. 
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� MOVIE REVIEW FROM PRINT SOURCE  

Rev. of Title of Movie, by First and Last Name(s) of Reviewers. Title of Source Date of Publication: Page  

 Number(s). Print.  

Example: 

Rev. of Talladega Nights: The Ballad of Ricky Bobby, by Richard Brody. The New Yorker 6 Nov. 2006: 5.  

 Print.  

 Electronic  Sources  
A WORK FOUND ONLY ON THE WEB  

 
When citing a source from the World Wide Web, the following pieces of information should be included in 
the citation. If not all information is available, cite what is given.  
1. Name of Author [Last name, First name] 
2. “Title of Work” 
3. Title of overall Website 
4. Publisher or Sponsor of the site; if not available, use N.p. 
5. Date of Publication [Day, Month, Year] ; if not available, use n.d. 
6. Medium of Publication [Web] 
7. Date of Access [Day, Month, Year] 

 
� WEBSITE  

 

Example: 

Lessig, Lawrence. "Free Debates: More Republicans Call on RNC." Lessig 2.0. N.p., 4 May 2007. Web. 15  

 May 2008. 

� ARTICLE FROM AN ONLINE NEWSPAPER  

Example:   

Achenbach, Joel. "America's River." Washington Post. Washington Post Company, 5 May 2002. Web. 20 

 May 2002. 

 
� ARTICLE FROM AN ONLINE MAGAZINE ACCESSED ON THE WWW  

Example: 

Levy, Steven. "Great Minds, Great Ideas." Newsweek. Newsweek, Inc., 27 May 2002. Web. 30 June 2003. 
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� COPYRIGHTED IMAGE FROM AN ELECTRONIC SOURCE  

 
Example: 

Brandio, Flavio Cruvinel. Swallow-tailed Hummingbird. Flickr Yahoo! Inc., 16 Nov. 2006. Web. 13 Dec. 

 2006. 

Note: Titles of images are italicized, not put in quotation marks.  

 

� MOVIE/FILM REVIEW FROM A WEBSITE  

Example: 

Orndorf, Brian. “ ‘Rush Hour 3’ Tired, Yet Still Wild Fun.” OhmyNews On Screen. OhmyNews, n.d. Web. 17  

 Aug. 2007.  

 

 Citing Resources Accessed on the Web or in a Database  
after being Published in Print 

Note: Refer to the print template for the initial citation information. Then include the 
following three components to indicate the online medium:  

1. Title of Database or Website 
2. Medium of Publication [Web] 
3. Date of Access [ Day, Month, Year] 

 
� AN ARTICLE FOUND IN A DATABASE  

Stone, Andrea. "White House Hopes Volunteer Initiative Will Help Economy." USA Today 19 June 2009: A2.  

 Opposing Viewpoints. Web. 29 July 2009.  

 

� ONLINE BOOK -  QUESTIA  

Hamburger, Michael, and Christopher Middleton, eds. Modern German Poetry, 1910-1960.  New York: 

Grove Press, 1962. Questia. Web. 5 Dec. 2006.  

 

� ARTICLE FROM AN ONLINE SCHOLARLY JOURNAL IN A DATAB ASE  

Chang, Patricia. “What’s next for Iraq?(After the U.S. leaves).” The Christian Century. 126. 8  (2009): 22. 

 Student Resource Center – Gold. Web. 7 July 2009.  
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Citing Resources Accessed on the Web or in a Database  
after being Published in a Non-Print Medium 

 
Note: Refer to the print template for the initial citation information. Then include the 
following three components to indicate the online medium: 

1. Title of Database or Website 
2. Medium of Publication [Web] 
3. Date of Access [ Day, Month, Year] 
 

� VIDEO CLIP  

West, Kanye. Amazing. 2009. YouTube. YouTube, LLC. n.d. Web. 8 Feb. 2009.  

Note: Titles of video clips are italicized, not put in quotation marks.  

 
UNITED STEAMING  

Biologix: The Central Nervous System and Brain. Discovery Education. Discovery Communications, LLC. 

 1997. United Streaming. Web.  29 July 2009.  

 

 

 

Citing Other Specific Resources 
 
Note: There will be some instances in using Gale’s Infotrac databases and United 
Streaming where previous publication information does not apply. In these cases, the 
database is the original source of publication.   
 
The following pieces of information should be included in the citation. If not all information is available, 
cite what is given. 
1. Name of Author [Last name, First name] 
2. “Title of Work” 
3. Title of overall Website 
4. Publisher or Sponsor of the site; if not available, use N.p. 
5. Date of Publication [Day, Month, Year] ; if not available, use n.d. 
6. Title of Database or Website 
7. Medium of Publication [Web] 
8. Date of Access 
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Other Media Sources 
� PAINTING, SCULPTURE, OR COPYRIGHTED IMAGE FROM A PR INTED SOURCE 

Creator’s Last Name, Creator’s First Name. [if given] Title of the Work. [not all images will have an official  

 title, so substitute a descriptive title, such as Rainforest Image, but do not underline that title] Name of  

 the Institution or Individual that Owns the Work. [if given] Title of the Source. By Author’s First and  

Last Name. [if given] City of Publication: Publisher, Copyright Date. Page Number(s).  

 
Example: 

Oliver, Isaac. Self-Portrait. National Portrait Gallery. 500 Self-Portraits. London: Phaidon Press Limited,  

 2000. 111.  

� SONG 

Performer’s Last Name, Performer’s First Name. [if given] “Title of the Song.” By Composer’s First and Last  

 Name. [person who wrote the song] Title of the Album.  Name of Manufacturer or Production  

 Company, Copyright Date. Medium [Audiocassette, CD, or LP]. 

Example: 

“Requiem Lacrimosa Dies Illa.” By Wolfgang Amadeus Mozart. Essential Classics: 50 Classical Highlights.  

 St.Clair Entertainment Group Inc., 2005. CD.  

 
� VIDEOTAPE OR DVD  

Title of Tape or DVD. Dir. Director’s First Name and Last Name. Production Company, Year Produced. 

 Medium. [Film, DVD, videocassette, slide program, or filmstrip]  

Example: 

Global Warming: The Signs and the Science. Dir. Michael Taylor. PBS Home Video, 2005. DVD.  

 
� TV SHOW OR RADIO PROGRAM  

“Segment’s Title or Episode’s Name.” Title of Program. Station’s or Network’s Name, Place of Production.  

 Date of Broadcast. Medium of reception [radio or television].  

Example: 

“Teenage Spending.” 60 Minutes. CBS, New York. 3 Nov. 2005.Television. 
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Appendix A:  
Answers to Frequently Asked Questions About MLA Style 

 
 

1.  WHAT DOES MLA STAND FOR?       Modern Language Association 
 
2.  HOW MANY SPACES FOLLOW PERIODS AND COLONS IN AN ENT RY? 

• One Space   Example: The dog ate my homework. Really?  
 

3.  HOW DO I FORMAT THE WORKS CITED PAGE?  

• Do not number entries or use bullets. 

• All items are double spaced. No single spacing anywhere. 

• Each entry ends with a period.  

• Use a hanging indent for each entry that goes beyond one line.  All lines after the first line are indented 1 
tab.  

 
• Titles that are not in quotation marks must be italicized.  Check with your teacher.  Be consistent. 

 
• Alphabetize by the author’s last name or the first important word of the title. (See Question 4)  

 
4.  HOW DO I ALPHABETIZE ON THE WORKS CITED PAGE? 

• Titles that start with numbers are first—in numeric order. 
 
• If there is no author, alphabetize by the first important word of the title. Do not alphabetize using 

“The,” “A,” or “An”, but do not remove these words from the title.  
 

• If the same author wrote two or more of the sources you are using, type  ---.  instead of writing the 
author’s name the next you enter it on the page.  See the sample Works Cited page for an example.                

 
5. HOW DO I WRITE AUTHOR NAMES ON THE WORKS CITED P AGE? 

One author:      Jones, James. 
Two authors:     Jones, James, and Harry Smith. 
More than two authors:    Jones, James, et al. 
Name with a middle initial:   Jones, James W. 
Name with a title, such as Dr.:   Do not include the title. 
 

    NOTE: If no author is given, the entry will begin with the editor’s name and will use the same format for  
      authors shown above. This applies to both print and electronic information. 
 
6.  HOW DO I WRITE PAGE NUMBERS ON THE WORKS CITED PAGE? 

NOTE: Page numbers should only be used for electronic documents (such as Website articles) if the pages you are viewing on 
the screen are numbered.  DO NOT use printer-generated page numbers found on the upper right corner of your printout.  

• A source on page 4:  
   4  
 
• A source on pages 4 through 12:  
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 4-12 
• A source starting on page 4 and continuing later in the book or magazine:    

4+ 
7.  HOW DO I WRITE DATES ON THE WORKS CITED PAGE? 

 
A. Month & Year 

• Abbreviate the Month (except May, June, and July)    
Examples:   Jan.  Feb.  Mar.  Apr.   Aug.  Sept.  Oct.  Nov.  Dec. 

 
• Do not use a comma between month and year 

Example:    Sept. 2006 
 

B.  Full Date 
• Include Day  Month Year – in this order  
      Example:    15 Aug. 2004   

   
 
8.  WHAT’S THE DIFFERENCE BETWEEN A WORKS CITED PAG E AND A BIBLIOGRAPHY? 
 
 Works Cited Page:   

Provides the reader, or your teacher, with a list of all the resources or works that you cited within the 
text of your paper, the contents of your speech, or within your project.   
 
Bibliography: 
A complete list of all the resources that you consulted or used in some way while putting your paper, 
project, or speech together, even if they were not actually cited in the paper, project, or speech.  

 
______________________________________________________________________________________ 

 

ANSWERS TO OTHER FREQUENTLY ASKED QUESTIONS 
 
1.  WHAT IS THE DIFFERENCE BETWEEN CITING A WEBSITE  ARTICLE AND AN ARTICLE 

FROM A SUBSCRIPTION DATABASE LIKE GALE? 
 

 Website Article from a Publicly Available Website: 
 Usually lower-quality research and, therefore, generally not recommended because the information is  
 not guaranteed to be accurate or unbiased and is unlikely to have been reviewed by experts.  This is a  
 Website that anyone can view and that anyone could have created, such as Wikipedia.org.   
 
 Website Article from a Site Requiring a Subscription or Registration: 
 Information may be a little higher in quality but is still unlikely to have been reviewed by an expert and  
 could be biased or inaccurate.  However, the site may have a strong reputation for quality, such as  
 CNN.com.   

 
Subscription Database Article: 
Higher-quality research because the information is paid for and goes through a quality control process  
that often includes review by authority figures in a specific field of knowledge.  Information is written  
by scientific researchers or experts in a particular field of knowledge.  
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2.  WHAT SHOULD I DO WHEN A WORK CITED ENTRY FLOWS OVER TO THE NEXT PAGE? 
It is better for the reader to see a work cited entry in its entirety, so use the Enter key to move all lines 
of the entry to the next page, even if this leaves a gap at the bottom of the previous page.  
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Appendix B: 
General Formatting Specifications for MLA Style 

 
1. Paper  

• Use 8 ½ x 11 in. white paper. 
• Print on one side of the paper only. 
 

2. Margins  
• 1” on all sides  
• Set the margins of the paper under “File” => “Page Setup” before starting to type. 
• Do not justify your margins on the right side of the page.  
 

3. Font  
• Choose an easily readable typeface (e.g. Times New Roman)  and 12 pt. font for all typing.  

That includes the body of the paper, title, heading, and works cited page.  
 

4. Spacing  
• The entire document is double-spaced.  That includes the body of the paper, title, heading, and 

works cited page. 
• Before you start typing, set the document to double spacing.  

1. Select “Format” => “Paragraph” 
2. Under “Line Spacing” select “Double” from the drop-down menu 
NOTE: If you’ve already started the document, highlight the text and follow steps 1 and 2.  

 
5. Heading  

• A 4-line heading is on the first double-spaced line following the page number.  The heading is 
typed in the upper-left corner of the first page of the paper.  

• The 4-line heading consists of: 
(Line 1) Student’s First and Last Name  
(Line 2) Teacher’s Name 
(Line 3) Course Name  
(Line 4) Date [Day Month Year]  

• MLA does not require a title page.  
• The heading is not bolded or underlined.  
• The heading is double-spaced.  
 

6. Title  
• Follows the 4-line heading. 
• Is double-spaced like the rest of the document 
• Is NOT bolded OR underlined OR “in quotes” OR italicized    
• Is centered on the page. 

 
7. Paragraphs 

• The first line of each new paragraph is indented 1 tab. 
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8. Page Numbers  

• Numbered consecutively throughout the paper through the works cited page(s), which are the 
last pages of the paper.  

• Placed in the upper right-hand corner of all pages.  
• Contain the student’s last name, one space, and then the page number. 
• Are set up on the document’s first page in the document’s header.  

1. Go to “View” => “Header and Footer”  
2. When the Header box appears at the top of the page, tab over to right side of the box. 
3. Type your last name.  Then, hit the spacebar one time.   
4. In the Header and Footer box that appears on the screen, click on the first icon (a piece 

of paper with a # on it). This will automatically place the numbers on your pages for 
you.  

5. Close the Header and Footer box.  
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Lynn Smith  

Mr. Elfrink  

Spanish II  

5 Dec. 2006  

The Art of Spanish Cuisine 

 When thinking of Spanish cuisine, does Taco Bell come to mind?  How about the local Mexican 

restaurant on the corner?  To many in the Spanish world, the art of Spanish cuisine remains a revered and 

deeply rooted part of one’s culture.  Recipes pass from generation to generation, creating a lineage of Spanish 

cuisine.  From ingredient selection to the finest details of preparation and presentation, the art of Spanish 

cuisine proves to be a part of Spanish culture that deserves recognition and further understanding.   

 XXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXX XXXXXXX

XXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXX XXXXXXXXXX

XXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXX XXXXXXXXXX

XXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXX XXXXXXXXXX

XXXXXXXXXXXXXXX. 

 XXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXX XXXXXXX

XXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXX XXXXXXXXXX

XXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXX XXXXXXXXXX

XXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXX XXXXXXXXXX

XXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXX XXXXXXXXXX

XXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXX XXXXXXXXXX

.  

Student’s Name   1 in.    ½ in.   

Title : No bold, no underline, 
no italics 

Indent 1 tab  

Date: Day   Month  Year 

Class 

Instructor’s Name   

1 in.    

1 in.    

Page Number 
in Header  
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INTEGRATING QUOTES INTO A PAPER  
By Dr. Harold William Halbert  

One problem we often face when we write a source-based paper is how to 
handle quotations. Simply deciding when to use a quote or paraphrase can be 
difficult; the actual mechanics of signaling the use of a quote, integrating the 
quote into a sentence, and then making sure you put the punctuation in the right 
place can be challenging.   

In the following pages, these issues will be explored: 
   

When to paraphrase vs. 
when to quote   

Using signal phrases   

Using the source's name  

Punctuating quotes  

Quotes in Quotes  

Block quotes  

Special issues with poetry   

Cutting text out of quotes using 
ellipses (. . . )  

Adding text to quotes  

Adding italics for emphasis  

Dealing with typographical errors in the 
original quote  

When to Paraphrase vs. When to Quote :  

When we quote a passage, we do so in order to analyze how a specific effect 
works in the text. If there is no clear effect that we wish to discuss, we may want 
to simply paraphrase the key incidents or details of a passage so as to avoid 
slowing down our own writing with the words of someone else.  

We need to be careful when we paraphrase, though. We have to create a 
sentence that uses a different sentence structure and language. If our 
paraphrase contains elements that are a word-for-word match to the source text 
or so close that it is difficult to tell the difference, we could be charged with 
plagiarism because it looks like we are trying to steal the words or ideas of 
someone else. In the case of word-for-word paraphrasing, rewrite it or turn it into 
a direct quote. In the case of a near quote, give a citation for the sentence as if it 
was a direct quote, just to be safe.  

Using Signal Phrases :  

One common error a lot of people make when they include a quote is that they 
tend to put the quote in a sentence by itself. Unfortunately, we cannot do this 
because when we do, we are giving the quote without a specific analytical 

Appendix E 
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context. We need to use what Diana Hacker calls a signal phrase to introduce 
the quote and give our readers a context for the quote that explains why we are 
taking the time to include it in our paper.  

Take, for example, this section from a paper on Narrative of the Life of 
Frederick Douglass, An American Slave, Written by H imself :  

We can see Douglass' marriage as an assertion of his ownership of himself. 
"What Douglass's certificate of marriage, which is transcribed in full in chapter 
11, signifies is that the black man has repossessed himself" (Baker 170).  

In this example, the quote from an essay by Houston  A. Baker, Jr. thrusts 
itself into the flow of the paper, disturbing reade rs because there is no 
warning that the quote is coming. Yet, with a signa l phrase, we can make 
the use of the quote seem more natural to readers:   

We can see Douglass' marriage as an assertion of his ownership of himself, as 
Houston A. Baker, Jr. argues in his essay "The Economic of Douglass's 
Narrative": "What Douglass's certificate of marriage, which is transcribed in full in 
chapter 11, signifies is that the black man has repossessed himself" (170).  

By including a reference to Baker and his essay in the sentence before 
giving the quote, we let the reader know that we ar e using someone's 
opinion to support our own, giving the quote a cont ext that the reader finds 
relevant to our overall point.   

According to the St. Martin's Guide , there are three main ways to set up a 
signaling phrase:   

1. With a complete sentence followed by a colon.   

The effects of Auld's prohibition against teaching Douglass to read were quite 
profound for Douglass: "It was a new and special revelation" (29).  

2. With an incomplete sentence, followed by a comma .  

Douglass argues that Auld's prohibition against literacy for him was a profound 
experience, saying, "It was a new and special revelation" (29).  

3. With a statement that ends in that .  

The importance of Auld's prohibition to Douglass is clear when he states that "It 
was a new and special revelation" (29).  
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You can, however, build your own signal phrases by mixing these three basic 
styles with verbs that describe your source's attitude towards the subject of the 
quote. Here is a list of such verbs, as well as other phrases you can use: 
   

admits  
agrees  
argues  
asserts  
believes  
claims  
compares  
confirms  
contends  
declares  
denies 

emphasizes  
insists  
notes  
observes  
points out  
reasons  
refutes  
rejects  
reports 

responds  
replies  
suggests  
thinks  
writes   

In _____'s words   

According to 
____'s (notes, 
study, narrative, 
novel, etc.)  

Using the Source's Name   

Generally, the first time we use a source in a paper, whether it be through a 
paraphrase or a quote, it's a good idea to use the author(s) full name(s) and the 
title of the source we are using in the actual sentence so that readers feel that we 
have introduced the source to them. After we have introduced the source, it's 
perfectly acceptable to refer to the author by his or her last name or even to 
leave the name out of the body of our text and simply include it in the citation.  

First use:   

In his Narrative of the Life of Frederick Douglass, An American Slave, Written by 
Himself, Frederick Douglass argues that "Slavery proved as injurious [to slave 
holders] as it did to me" (31).  

Second use:   

Douglass earlier argues that slavery was "a fatal poison of irresponsible power" 
to slave holders (29).  

Third use:   

The use of the word "hypocrites!" suggests that even the religious faith of the 
slave holders was tainted by their ownership of other humans (Douglass 77).  
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Punctuating Quotes   

Punctuating quotes can be frustrating because we often get confused about 
where to put punctuation. The following chart offers a straightforward view on 
how to punctuate the end of a quote: 
   

Periods & 
Commas  

They always go inside the quotation marks  even if there is no 
period or comma at the end of the quoted material i n the 
original text.   

Exception : If there is a parenthetical citation immediately after 
the quote, the period or comma goes after the paren thetical 
citation.  

Question 
Marks  
&  
Exclamation 
Points  

If the original quote ends with an exclamation mark or a 
question mark , we must include it inside  the quotation marks.   

ORIGINAL TEXT:  
Will not a righteous God visit for these things?  

QUOTED TEXT:  
When Douglass asks, "Will not a righteous God visit for these 
things?" he raises the question of doubt about the future salvation of 
the "Christian" slaveholders.  

Notice that we don't put a comma after the question  mark, even 
though normally we would if there was not a questio n mark. We 
omit the comma to avoid double punctuation.   

 
If we want to use a  quoted statement in a question or 
exclamation we create , then the question mark or the 
exclamation mark goes outside  the quotation marks.   

ORIGINAL TEXT: 
The grave is at the door. (FD 38)   

QUOTED TEXT: 
How can we take Douglass seriously when he indulges in 
excessively romanticized language such as "The grave is at the 
door"? 

Colons &   
Semi-Colons  

Colons and semi -colons always go outside the quotation, even 
if the original quoted material ends with either fo rm of 
punctuation.  
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Quotes within Quotes   

One of the messiest types of quotes to punctuate is a quote within a quote. 
Sometimes we want to use quoted dialogue or a quote that includes a word set 
off by quotation marks. To mark a quotation within the text we want to quote in 
our own paper, we need to enclose them in single quotation marks ('. . .'):  

ORIGINAL TEXT: 
I got hold of a book entitled "The Columbian Orator." (FD 32)  

QUOTED TEXT:  

Because Douglass "got hold of a book entitled 'The Columbian Orator,'" he was 
able to learn how to read and broaden his mind.  

Notice that the comma at the end of the quote goes inside not only the 
double quote but the single quote mark as well.   

 

 

 

 

 

Block Quotes   

One problem that occurs when we are working with longer quotes is that our 
paragraphs grow to be huge on the page. In order to give the reader a visual 
break, we use block quotes to physically separate the quote from the rest of our 
text.  Current MLA style states that prose text over four lines should be put in a 
block quote (poetry is handled differently, as we discuss below).  

In the past, a block quote needed be single- spaced  and indented five 
spaces from the right and left margin. Nowadays, th ough, the MLA wants 
writers to DOUBLE-SPACE the block quote and indent TEN spaces from 
the LEFT margin, as is shown in the following examp le:   
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Notice how the text is indented ten spaces from the left margin (an effect you can 
get in most word processors by typing the text, highlighting it, and then clicking 
on FORMAT--> PARAGRAPH-->INDENT two times) and that it is double-
spaced.  

Notice too that the block quote is technically part of the preceding sentence 
because of the use of a colon at the end of the introductory statement.  We also 
do not indent the text after the end of the block quote; we are still in the same 
paragraph. Be aware that the parenthetical citation goes outside the final period. 
Finally, note that we do not use quotation marks in a block quote; the indentation 
tells readers that it is a quote.  

Special Issues with Poetry   

Poems (and song lyrics, for that matter) are often the most difficult type of 
texts to quote because part of the impact of poetry  lies in the visual breaks 
between lines. To try to capture this visual aspect , there are three special 
rules we use when we quote poems:   

1. In poetic quotes less than three lines, we put a  slash (/) between the lines 
to mark the line break:   

In "The Poem," when William Carlos Williams writes, "It's all in/the sound" (1-2), 
he is arguing for the lyrical quality of words.  
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2. In poetic quotes three or more lines long, we ne ed to block quote them 
by indenting ten spaces from the left. Unlike a pro se block quote, however, 
we use a line of text for each line of the poem . Also, we do not double 
space a block quote from a poem . Instead, we need to attempt to recreate 
both the line spacing and the horizontal placement  of a poetic line in 
relation to the lines that come before and after it , as is done in the following 
example:   

 

Our block quote looks like the poem. To try and mai ntain the illusion, we 
put the parenthetical citation under the last line.   

3. Instead of page numbers, we use line numbers fro m the poem to identify 
the quote.   

Cutting Text out of Quotes Using Ellipses   

Sometimes we need to cut words, phrases, sentences,  or even whole 
paragraphs or pages out of a quotation in order to present to the reader a 
concise quotation that illustrates the issue we wan t to discuss. We can 
make such cuts using an ellipse, which is made from  three periods, with a 
space before and after each period (like this: " . . . ").   

Cutting unnecessary words can be a great way to foc us our point and 
conserve space, but be warned: if we cut too many w ords and change the 
overall tone or meaning of a quote, we will be guil ty of misquoting our 
source. In particular, we cannot omit key words lik e "no," "not," and any 
other negative word in an effort to make a source m ore agreeable with our 
point. Getting caught omitting such words with our handy ellipse at best is 
embarrassing, and at worst, grounds for plagiarism.   

As an example of how this might work, let's look at  the following quote 
from page 184 of Mary Shelley's Frankenstein :  
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Think not, Walton, that in the last moments of my existence I feel that burning 
hatred and ardent desire of revenge I once expressed; but I feel myself justified 
in desiring the death of my adversary.  

Here we have the words of Victor Frankenstein to th e narrator, Walton, 
towards the end of the novel. The entire quote is q uite powerful and could 
be used as is without any alteration. We could, how ever, decide to make 
alterations to either accommodate an introductory q uote or to streamline 
the quote for either effect or space:   

In what appears to be his dying breath, Frankenstein begs Walton to, "Think not . 
. . that in the last moments of my existence I feel that burning hatred and ardent 
desire of revenge . . . but I feel myself justified in desiring the death of my 
adversary."  

Here we cut out the reference to Walton since we us ed his name in the 
signal phrase we attached to the sentence. We also cut out the reference to 
"I once expressed" in order to get to the point mor e quickly. We could not, 
however, get away with removing the "not" from the sentence because that 
would change Frankenstein's words into a command to  think that he is in 
fact full of hatred and revenge.   

In larger passages, if we wanted to cut out the end of a sentence or even 
several sentences , we can do so, but we need to add another period to the 
ellipse, bringing the total number of periods in it  to four  (like this: " . . . . "). 
The fourth period indicates that one or more senten ce endings have been 
omitted. In theory, the number of sentences omitted  could be limitless, but 
in practical terms, it's a good idea not to cut out  more than a couple of 
sentences because beyond that, it is extremely unli kely that you can cut 
out that much text without creating a false impress ion about the quote's 
original context. Consider a longer version of the previous passage from 
Frankenstein :  

Think not, Walton, that in the last moments of my existence I feel that burning 
hatred and ardent desire of revenge I once expressed; but I feel myself justified 
in desiring the death of my adversary. During the last days I have been occupied 
in examining my past conduct; nor do I fid it blamable. In a fit of enthusiastic 
madness I created a rational creature, and was bound towards him, to assure, as 
was in my power, his happiness and well-being. This was my duty; but there was 
still another still paramount to that. My duties towards the beings of my own 
species had greater claims to my attention, because they included a greater 
proportion of happiness or misery.  
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If we wanted to, we could cut out a sentence or two , like this:   

On his apparent death bed, Frankenstein seeks to excuse his wish to see his 
creation die, saying,  

I feel myself justified in desiring the death of my adversary . . . . In a fit of 
enthusiastic madness I created a rational creature, and was bound 
towards him, to assure, as was in my power, his happiness and well-
being. This was my duty; but . . . . My duties toward the beings of my own 
species had greater claims to my attention, because they included a 
greater proportion of happiness or misery. (184)  

By cutting out the "examination" sentence and the e nd of the "paramount" 
sentence, we show the reader only the key ideas fro m the text we want to 
discuss. If we had included the missing segments, t he reader might wonder 
if we have any point to make at all or if we were g oing to quote the whole 
book.   

One final note on ellipses: we do not need to put a n ellipse at the beginning 
or end of a quote if we do not start the quote at t he beginning of the 
sentence and end it at the close of the sentence. T hus, if we want to quote 
the phrase "beings of my own species had greater cl aims," we do not have 
to include an ellipse before or after the quote:   

ORIGNIAL TEXT: 
My duties towards the beings of my own species had greater claims to my 
attention, because they included a greater proportion of happiness or misery.  

INCORRECT QUOTE: 
By arguing that ". . . beings of my own species had greater claims . . ." (184), 
Frankenstein in essence displays a racist attitude.  

CORRECT QUOTE: 
By arguing that "beings of my own species had greater claims" (184), 
Frankenstein in essence displays a racist attitude.  

Adding Text to Quotes   

Generally, adding text to quotes is forbidden. Afte r all, if we could freely 
add text to a quote, we could make a quote say anyt hing we wanted. There 
are times, however, when it is acceptable to add a word or phrase to a 
quote, and when we do, we enclose the added material in brackets  (like 
these: [ ]).   

When we do add material to quotes, we do it to clarify references  that do 
not make sense because we do not have the entire te xt in front of us or to 
make the quote fit into the grammatical structure o f our sentence.   
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Example 1:   

ORIGINAL TEXT: 
He was told he was at the barn. (FD 59)  

WITH BRACKETED TEXT: 
Douglass' matter-of-fact reporting, such as in statements like, "He [Hamilton] was 
told he [William Freeland] was at the barn" (59) makes the Narrative easy to 
follow.  

Because our quote doesn't include the preceding sen tences that give us 
the names each "he" refers to, we need to add them to our quotation.   

Example 2:   

ORIGINAL TEXT: 
Mr. Hopkins could always find some excuse for whipping a slave. (FD 53)  

WITH BRACKETED TEXT: 
Because Mr. Hopkins was "always [finding] some excuse for whipping a slave" 
(53), he epitomized the hypocrisy of slaveholding clergy.  

The grammar of the original sentence did not allow for the sentence 
structure of our sentence, so we modified the verb form from the original 
sentence in our quote. Generally, when we modify a word in a quote, we 
simply change the form of the word rather than pick ing a whole new word.   

Adding Italics to a Quote for Emphasis   

Sometimes when we use a quote, we want to draw atte ntion to words or 
phrases to emphasize a particular feature of the wr iting. To do so, we use 
italics  to make the key word or phrase stand out from the rest of the quote. 
If we choose to add italics, though, we have to ack nowledge that we 
modified the quote, so we add a parenthetical citat ion containing the words 
"emphasis added" to the end of the sentence:   

ORIGINAL TEXT: 
It rekindled the few expiring embers of freedom, and revived in me a sense of my 
own manhood. (FD 50).  

WITH ADDED EMPHASIS: 
The fact that the fight with Covey renewed Douglass' "sense of . . . manhood" 
suggests that more than just his sense of humanity was at stake (50, emphasis 
added): his masculine identity was also at risk because of slavery.  
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Note that in this example, the "emphasis added" is included in the same 
parenthetical citation as the page citation. This s aves space and makes our 
paper flow better.   

Dealing with Errors in the Original Quote   

One of the touchiest issues to deal with in quoting  a source is how to 
handle errors made by the original writer. Because we have to stay true to 
the quote as it appears in the source text, we must  include the error in our 
quotation. Unfortunately, our readers may be unawar e that the error was 
the original author's and assume that the error is ours, lowering our 
credibility. To avoid this quandary, we can simply add the bracketed phrase 
"[ sic ]" to indicate that the error was in the source tex t:   

ORIGINAL TEXT: 
The elefant was pretty cool.  

AS A QUOTE: 
By noting that the "elefant [sic] was pretty cool," the boy took his first step 
towards a promising career as a field biologist.  

Be aware that sometimes sic  can be used as a not-so-subtle barb against 
the reliability of a source, so use it cautiously a nd recheck the tone created 
by its use.  

 
This page was originally created by Dr Harold William Halbert for Lehigh 
University's Center for Writing, Math, and Study Skills. This page may be used 
for instructional purposes only without charge: simply give credit where credit is 
due.  
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